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Limited Warranty 

All products manufactured and sold by Digital Control Incorporated (DCI) are subject to the terms of a 
Limited Warranty. A copy of the Limited Warranty is included at the end of this manual; it can also be 
obtained by contacting DCI Customer Service, 425-251-0559 or 800-288-3610, or at DCI's website, 
www.digitrak.com. 

Important Notice 

All statements, technical information, and recommendations related to the products of DCI are based on 
information believed to be reliable, but the accuracy or completeness thereof is not warranted. Before 
utilizing any DCI product, the user should determine the suitability of the product for its intended use. All 
statements herein refer to DCI products as delivered by DCI and do not apply to any user customizations 
not authorized by DCI nor to any third-party products. Nothing herein shall constitute any warranty by DCI 
nor will anything herein be deemed to modify the terms of DCI’s existing Limited Warranty applicable to all 
DCI products. The most recent version of this manual is available on DCI's website. 

Compliance Statement 

This equipment complies with Part 15 of the Rules of the FCC and with Industry Canada license-exempt 
RSS standards and with Australia Class License 2000 for LIPD (low interference potential devices). 
Operation is subject to the following two conditions: (1) this equipment may not cause harmful 
interference, and (2) this equipment must accept any interference received, including interference that 
may cause undesired operation. DCI is responsible for FCC compliance in the United States: Digital 
Control Incorporated, 19625 62nd Ave S, Suite B103, Kent WA 98032; phone 425-251-0559 or 800-288-
3610. 

Changes or modifications to any DCI equipment not expressly approved and carried out by DCI will void 
the user’s Limited Warranty and the FCC’s authorization to operate the equipment. 

CE Requirements 

  DigiTrak receivers are classified as Class 2 radio equipment per the R&TTE Directive and 
may not be legal to operate or require a user license to operate in some countries. The list of restrictions 
and the required declarations of conformity are available on DCI’s website, www.digitrak.com, under the 
Service & Support tab. Click on DOWNLOADS and select from the CE Documents pull-down menu to 
download, view, or print the documents. 

http://www.digitrak.com/
http://www.digitrak.com/customerservice/downloads.html
http://www.digitrak.com/customerservice/downloads.html
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Contact Us 

United States 

DCI Headquarters 

19625 62nd Ave S, Suite B103 

Kent, Washington 98032, USA 

+1.425.251.0559 / 1.800.288.3610 

+1.425.251.0702 fax 

dci@digital-control.com 

Australia 2/9 Frinton Street 

Southport QLD 4215 

+61.7.5531.4283 

+61.7.5531.2617 fax 

dci.australia@digital-control.com 

China 368 Xingle Road 

Huacao Town 

Minhang District 

Shanghai 201107, P.R.C. 

+86.21.6432.5186 

+86.21.6432.5187 fax 

dci.china@digital-control.com 

Europe Brueckenstraße 2 

97828 Marktheidenfeld 

Germany 

+49.9391.810.6100 

+49.9391.810.6109 fax 

dci.europe@digital-control.com 

India DTJ 1023, 10th Floor 

DLF Tower A, DA District Center 

Jasola, New Delhi 110044 

+91.11.4507.0444 

+91.11.4507.0440 fax 

dci.india@digital-control.com 

Russia Molodogvardeyskaya Street, 4 

Building 1, Office 5 

Moscow, Russia 121467 

+7.499.281.8177 

+7.499.281.8166 fax 

dci.russia@digital-control.com 

mailto:dci@digital-control.com
mailto:dci.australia@digital-control.com
mailto:dci.china@digital-control.com
mailto:dci.europe@digital-control.com
mailto:dci.india@digital-control.com
mailto:dci.russia@digital-control.com
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Dear Customer, 

Thank you for choosing a DigiTrak locating system. We are extremely proud of the equipment we 
have been designing and building in Washington State since 1990. We believe in providing a 
unique, high-quality product and standing behind it with superior customer service and training. 

Please take the time to read this entire manual, especially the section on safety. Also, please fill 
in the product registration card provided with this equipment and either mail it to DCI 
headquarters, fax it to us at 253-395-2800, or complete and submit the form online at our 
website, www.digitrak.com. We will put you on the Digital Control mailing list and send you 
product upgrade information and our FasTrak newsletter. 

Feel free to contact us if you have any problems or questions. Our Customer Service department 
is available 24 hours a day, 7 days a week. International contact information is available on our 
website. 

As the horizontal directional drilling industry grows, we’re keeping our eye on the future to 
develop equipment that will make your job faster and easier. Visit us online any time to see what 
we’re up to. 

We welcome your questions, comments, and ideas. 

Digital Control Incorporated 
Kent, Washington 
2013 

 

See our DigiTrak Training Videos on YouTube at www.youtube.com/dcikent. 

 

http://www.digitrak.com/
http://www.youtube.com/dcikent
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Safety Precautions and Warnings 

Carefully review this manual and be sure you always operate your DigiTrak locating system properly to 
obtain accurate depth, pitch, roll, and locate points. If you have any questions about the operation of the 
system, please contact DCI Customer Service for assistance. 

General 

 

Warning All operators must read and understand the following safety 
precautions and warnings and must review this operator’s manual 
before using the DigiTrak F5 Locating System. 

  

 

Serious injury and death can result if underground drilling equipment makes 
contact with an underground utility such as a high-voltage electrical cable or a 
natural gas line. 

 

Substantial property damage and liability can result if underground drilling 
equipment makes contact with an underground utility such as a telephone, cable 
TV, fiber-optic, water, or sewer line. 

 

Work slowdowns and cost overruns can occur if drilling operators do not use the 
drilling or locating equipment correctly to obtain proper performance. 

 

DCI equipment is not explosion-proof and should never be used near flammable 
or explosive substances. 

 

In the event of electrostatic shock, the display screen may go blank. No data loss 
will occur. Click the trigger to reset the receiver, or toggle down to reset the 
remote display. 

 

Hot surfaces can occur on cable transmitters if housing requirements are not met. 
Always ensure the transmitter is installed properly in the housing during use. 

 

Directional drilling operators MUST at all times: 

 Understand the safe and proper operation of drilling and locating equipment, including the use of 
ground mats and proper grounding procedures. 

 Ensure that all underground utilities have been located, exposed, and accurately marked prior to 
drilling. 

 Wear protective safety clothing such as dielectric boots, gloves, hard hats, high-visibility vests, and 
safety glasses. 

 Locate and track the transmitter in the drill head accurately and correctly during drilling. 

 Maintain a minimum distance of 8 in. (20 cm) from the front of the receiver to the user’s torso to 
ensure compliance with FCC requirements. 

 Comply with federal, state, and local governmental regulations (such as OSHA). 
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 Follow all other safety procedures. 

DigiTrak locating systems cannot be used to locate utilities. 

Continued exposure of the transmitter to heat due to frictional heating of the drill head can cause 
inaccurate information to be displayed and may permanently damage the transmitter.  

Remove the batteries from all system components during shipping and prolonged storage; damage 
caused by leakage may occur. 

Equipment and Battery Disposal 

 

This symbol on equipment indicates that the equipment must not be disposed of with your 
other household waste. Instead, it is your responsibility to dispose of such equipment at a 
designated collection point for the recycling of batteries or electrical and electronic 
equipment. If the equipment contains a banned substance, the label will show the pollutant 
(Cd = Cadmium; Hg = Mercury; Pb = Lead) near this symbol. Before recycling, ensure 
batteries are discharged or the terminals are covered with adhesive tape to prevent 
shorting. The separate collection and recycling of your waste equipment at the time of 
disposal will help conserve natural resources and ensure it is recycled in a manner that 
protects human health and the environment. For more information about where you can 
drop off your waste equipment for recycling, please contact your local city office, your 
household waste disposal service, or the shop where you purchased the equipment. 

The battery charger provided with your DigiTrak locating system is designed with adequate safeguards to 
protect you from shock and other hazards when used as specified within this document. If you use the 
battery charger in a manner not specified by this document, the protection provided may be impaired. Do 
not attempt to disassemble the battery charger, it contains no user-serviceable parts. The battery charger 
shall not be installed into caravans, recreational vehicles, or similar vehicles. 

Pre-Drilling Testing 

Before each drilling run, test your DigiTrak locating system with the transmitter inside the drill head to 
confirm it is operating properly and providing accurate drill head location and heading information. 

During drilling, the depth will not be accurate unless: 

 The receiver has been properly calibrated and the calibration has been checked for accuracy so the 
receiver shows the correct depth. 

 The transmitter has been located correctly and accurately and the receiver is directly above the 
transmitter in the drill head underground or at the front locate point. 

 The receiver is placed on the ground or held at the correct height-above-ground distance, which has 
been set correctly. 

Always test calibration after you have stopped drilling for any length of time. 

Interference 

Interference can cause inaccuracies in the measurement of depth and loss of the transmitter’s pitch, roll, 
or heading. Always perform a background noise check prior to drilling. 

 Sources of interference include, but are not limited to, traffic signal loops, invisible dog fences, cable 
TV, power lines, fiber-trace lines, metal structures, cathodic protection, telephone lines, cell phones, 
transmission towers, conductive earth, salt, salt water, rebar, and radio frequencies. 
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 Interference at the remote display may also occur from other sources operating nearby on the same 
frequency, such as car rental agencies using their remote check-in modules or other directional 
drilling locating equipment. 

 Background noise must be minimal and signal strength must be at least 150 points above the 
background noise during all locating operations. 

 Because this equipment may generate, use, and radiate radio frequency energy, there is no 
guarantee that interference will not occur at a particular location. If this equipment does interfere with 
radio or television reception, which can be determined by powering the equipment off and on, try to 
correct the interference using one or more of the following measures: 

o Reorient or relocate the receiving antenna. 

o Increase the separation between the receiver and affected equipment. 

o Consult the dealer, DCI, or an experienced radio/TV technician for help. 

o Connect the DCI equipment to an outlet on a different circuit. 
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Introduction 

 

F5 TensiTrak System  

The DigiTrak F5 TensiTrak Pullback and Pressure Monitoring System allows you to monitor and save live 
pullback data electronically during horizontal directional drilling installations. The TensiTrak transmitter is 
a self-contained wireless device that measures and transmits real-time pullback data that includes 
product pull forces and downhole mud pressures. It is placed behind the reamer between a swivel and 
the product. The data is monitored and saved using an F5 receiver, which also transmits the data in real 
time to the remote display at the drill rig. The data saved in the receiver is uploaded to a computer using 
the LWD (log-while-drilling) software provided with the F5 system.  

The following types of data are monitored and saved with the F5 TensiTrak system:  

Monitored and saved on receiver Monitored only on receiver Saved on TensiTrak transmitter  

● Real-time pull force  ● TensiTrak temperature ● Maximum pull force  
● Maximum pull force  ● TensiTrak battery status  
● Real-time downhole mud  
 pressure 

● TensiTrak depth and  
 position 
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This operator’s manual begins by describing the primary components of the TensiTrak system, which 
include the TensiTrak transmitter, the F5 receiver, the FSD or MFD remote display, the LWD computer 
software, and the Bluetooth adapter used for communication between the receiver and the computer. 
Then it presents procedures for setting up the TensiTrak system in the field, recording data in the field, 
installing the LWD software, and using the software to upload, edit, view, archive, and e-mail TensiTrak 
data.  

Some terms and techniques used in this manual are considered basic to the F5 locating system. If you 
have never used the F5 system, then you are required to read the operator’s manual for the system 
(DigiTrak F5 Directional Drilling Locating System Operator’s Manual) before using the TensiTrak system.  

NOTE: You must know how to operate the F5 locating system prior to operating the F5 
TensiTrak system. 

You also must read the instructions in this TensiTrak system operator’s manual and familiarize yourself 
with the various menu screens on your F5 receiver before using the system for a pullback. If you have 
questions, please call DCI Customer Service. 
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System Components 

The F5 TensiTrak system has five main components, which are described in this section. 

 F5 TensiTrak Transmitter – A battery-powered device with sensors that continuously measure 
pullback data along with depth, position, temperature, and battery life and a transmitter that sends 
the data to an F5 receiver.  

 F5 Receiver – A locator or receiver used to display and record transmitter data; the data is then 
uploaded from the receiver to a computer.  

 FSD or MFD Remote Display – A remote display used to view TensiTrak data at the drill rig.  

 LWD Software – A computer application provided with the F5 system for uploading data from the 
receiver to a computer and for working with the TensiTrak data in the computer.  

 Bluetooth USB Adapter – A USB device required for the computer to communicate with the F5 
receiver to upload data.  

 

F5 TensiTrak Transmitter 

The F5 TensiTrak transmitter contains sensors that continuously measure the pull force, the downhole 
mud pressure, and the maximum pull force, which it also saves internally. It also monitors battery life and 
temperature and can track its position to a maximum depth of 60 ft (18.3 m). The pullback and transmitter 
data are sent every 4 seconds to the receiver. 

The TensiTrak transmitter is 5.5 in. (13.97 cm) in diameter and 19.5 in. (49.53 cm) long. It is installed 
behind the reamer or hole opener between the swivel and the product. The inner diameter of the pulling 
eye is 1.77 in. (4.5 cm). If the diameter of the TensiTrak transmitter is smaller than that of the reamer and 
product, you may want to shroud the transmitter; be sure that this is done with nonmetallic material. 

     

Leading End View Side View Trailing End View 

F5 TensiTrak Transmitter 

Leading end Trailing end 

Mud 
sensor 

Battery 
cap 

Pulling eyes 
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F5 Receiver 

The F5 receiver monitors the pullback and mud pressure data in real time and sends the data to the 
remote display on the drill rig. If you want to record the TensiTrak data, then you will use the DataLog 
function in the receiver. The DataLog function allows you to record your real-time data, to set flags along 
the pullback path, and to upload your TensiTrak data to a computer. The receiver will save 20 runs of 
data before uploading to a computer or deleting of jobs is required.  

         

F5 Receiver Side View (left) and Top View (right) 

The F5 receiver displays the transmitter’s temperature and battery status, and it can also be used to track 
the position and depth of the TensiTrak transmitter. The receiver must be programmed to detect the 
TensiTrak transmitter, and the system must be set up correctly for proper communication between the 
receiver, transmitter, and remote (see next section, Setting Up TensiTrak System). 

The receiver menus used for TensiTrak pullback jobs are located under the pressure-tension (P-T) 
DataLog menu, which is located on the receiver main menu. The P-T DataLog menu is also used for the 
F5 fluid pressure transmitter, but only its applications for the TensiTrak system are addressed in this 
manual. 

Trigger 
switch 

Toggle switch 
Display 
screen 
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FSD or MFD Remote Display 

The F Series Display (FSD) or Multi-Function Display (MFD) shows the  pull force, mud pressure, and 
maximum pull force when a TensiTrak transmitter is used with the F5 receiver and the system is properly 
set up. If you are using the system with an MFD remote display, software updates may be required; 
please contact DCI Customer Service. For more information about the FSD and MFD remotes, see the 
DigiTrak MFD/FSD Operator’s Manual. 

        

DigiTrak FSD Remote (left) and DigiTrak MFD Remote (right) 

 

LWD Software 

The LWD software is provided on a USB flash drive that also contains the DigiTrak LWD (Log-While-
Drilling) DataLog System Operator’s Manual, sample drill data, and Bluetooth drivers. The LWD software 
is used with other LWD applications, such as the Short Steering Tool (SST) system. However, all 
information that is pertinent to running the TensiTrak system is included in this TensiTrak manual. 
Instructions for the other LWD applications are not included herein. 

The LWD software requires a computer with at least the following system specifications: 

 Microsoft Windows XP, Vista, or 7 operating system 
 USB port 
 Pointing device (mouse)  
 Color printer for color graphs  

The pressure-tension (P-T) application in the LWD software is used with the TensiTrak system. It allows 
you to upload TensiTrak data from your F5 (or Eclipse) receiver, and to edit, annotate, and e-mail graphs 
and job information. A typical TensiTrak job screen as it appears in the LWD application window is shown 
below. 
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LWD Pressure-Tension Application Window  

Bluetooth USB Adapter  

The Bluetooth USB adapter (Amp’ed RF Model BT-210) is required for the F5 receiver to communicate 
with the computer for uploading data. The adapter has its own firmware to communicate and transfer data 
via Bluetooth technology. Drivers for the Bluetooth adapter are provided on the LWD flash drive and must 
be loaded before using the adapter to upload data. The LWD software must also be installed on the 
computer before TensiTrak data can be uploaded. 

 

Bluetooth USB Adapter 
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Setting Up the TensiTrak System 

The setup procedure involves powering on the TensiTrak transmitter, the F5 receiver, and the remote 
display; calibrating the transmitter to the receiver and verifying calibration; and assembling the downhole 
assembly. The instructions in this section are intended for use by someone who is already familiar with 
and knows how to use the F5 locating equipment. This section does not explain how to access the 
various menus or modes or how to check depth or signal strength—it assumes that you know how to do 
these things. Please refer to the DigiTrak F5 Directional Drilling Locating System Operator’s Manual if you 
need to review instructions for using the system. 

Powering On the TensiTrak Transmitter 

The TensiTrak transmitter is powered by three D-cell alkaline batteries, which may be packaged together 
with heat shrink, or by one SuperCell lithium battery in an adapter. Three D-cell batteries or one 
SuperCell battery will power the transmitter for approximately 30 hours. 

To power on the TensiTrak transmitter, remove the battery cap and insert either three individual or heat-
shrunk D-cell alkaline batteries or one SuperCell battery in its adapter into the battery compartment 
positive terminals first, as shown below; then replace the battery cap. 

        

Loading Batteries into TensiTrak Transmitter  

Once the batteries are properly installed and the battery cap is secure, the TensiTrak transmitter will zero 
any measurement data in memory and begin to measure and save data.  

Setting up Receiver and Remote 

Power up the F5 receiver, and then at the main menu click on the transmitter 
selection menu. From the transmitter selection menu, choose the TensiTrak option 
(right) to program your receiver so that it recognizes your TensiTrak transmitter.  

The receiver will return to the main menu with the locate mode highlighted for 
selection. Click the trigger to go to the locate mode screen, which will appear as 
shown below.  

Leading end (with 
battery compartment) 

Trailing end (with  
mud pressure sensor) 

 

TensiTrak 
Menu Option 

 

SuperCell battery 
and adapter 

3 D-cell  
batteries  

3 D-cell  
batteries in 
heat shrink 

Install batteries 
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Receiver TensiTrak Locate Mode Screen  

When the pressure-tension (P-T) DataLog function is enabled, the TensiTrak start recording menu will 
appear before the locate mode screen appears. The start recording menu allows you to choose to start a 
new TensiTrak job, append an existing job, or exit to the TensiTrak locate mode screen. See the next 
section, Recording Data and Using Receiver Menus, for instructions on how to use the P-T DataLog 
menus.  

If the P-T DataLog function is disabled, the TensiTrak locate mode screen will appear automatically and 
no data recording will occur on the receiver.  

NOTE: If a TensiTrak transmitter is not powered up or in range, then the TensiTrak locating mode screen 
on the receiver and on the remote will be blank.  

After powering up the receiver, then power up the FSD or MFD remote. The TensiTrak screen will appear 
on the remote as shown below when displaying TensiTrak data.   

    

Remote Display TensiTrak Screen  

Data point number 

recorded  

Signal strength 

Maximum force  
on TensiTrak 

during job 

Number of 
flags set 

TensiTrak 
temperature 

Annular mud 
pressure 

Instantaneous 

product pull force  

Maximum 
recorded force 

Instantaneous 

product pull force  

Annular mud 

pressure  
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Calibrating TensiTrak Transmitter to Receiver 
and Verifying Calibration 

It is only necessary to calibrate the F5 receiver to the TensiTrak transmitter if you will be tracking its depth 
during installation. If you are only tracking the position (not depth) of the TensiTrak transmitter, then it is 
not necessary to calibrate. Calibration should be completed in an interference-free environment. The 
calibration area should be free of passive and active interference sources.  

To calibrate your TensiTrak transmitter to your F5 receiver: 

1. Using a tape measure, position the TensiTrak transmitter at a distance of 10 ft (3 m) from the 
receiver, as shown in the figure below; measure from the centerline of the transmitter to the inside 
edge of the receiver as shown below. Be sure to position the TensiTrak transmitter with the pulling 
eyes “open to the sky” (facing up and down) rather than with the pulling eyes on edge. 

 

 

Calibration Setup 

2. Confirm that TensiTrak data is being displayed on the TensiTrak locate mode screen on the receiver. 

3. Open the receiver main menu, and select the calibration menu option. 

4. From the calibration menu, select the 1-point calibration option. 

5. Click the trigger to begin the calibration. Do not move the receiver or TensiTrak transmitter during 
calibration. A checkmark and four short beeps will confirm a successful calibration. If the calibration 
fails, verify the setup and try again or call DCI Customer Service. 

6. After a successful calibration, the display will automatically return to the TensiTrak locate mode 
screen. If the P-T DataLog function is enabled, the start recording screen will appear. Select exit to 
view the data without recording it. If the P-T DataLog function is disabled, the TensiTrak locate mode 
screen will appear automatically.  

7. Check the depth at two different locations to ensure a good calibration. 

Centerline of  
TensiTrak transmitter 

with pulling eyes  
“open to the sky” 

F5 
receiver 

10 ft (3 m) 

WRONG TensiTrak 
transmitter with  

pulling eyes  
on edge 
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Setting Up the TensiTrak Downhole Assembly 

The TensiTrak downhole assembly consists of the following items in the order listed here: reamer, swivel, 
D-ring, TensiTrak transmitter, another D-ring, and the product, including the clevises required to connect 
the D-rings to the swivel and the product. If the diameter of the product is larger than the diameter of the 
TensiTrak transmitter, DCI recommends the use of a nonmetallic shroud to keep material from bridging 
between the reamer and the product. Be sure to inspect the mud pressure sensor to ensure it is clear of 
dirt and shows no wear or damage before assembling the TensiTrak transmitter with the other downhole 
parts. 

The TensiTrak transmitter is installed into the downhole assembly and connected with D-rings so that it is 
positioned behind the reamer, between the swivel and the product as shown below 

 

TensiTrak Downhole Assembly 

It is critical that the TensiTrak transmitter’s mud pressure sensor end is positioned as the trailing end to 
ensure that formation cuttings do not get packed around the sensor.   

NOTE: If the TensiTrak transmitter’s batteries are installed when the TensiTrak transmitter is under load, 
you will not get correct readings during the installation. You must remove and replace the three 
D-cell alkaline batteries when the TensiTrak transmitter is not under load. Because the TensiTrak 
transmitter begins measuring and saving data as soon as the batteries are installed, you may 
prefer to power on the transmitter after it is positioned with the rest of the downhole assembly 
near the pull-in area. 

At this point, active monitoring is available on the receiver and the remote. If the P-T DataLog function is 
enabled and a job selection has been made, the TensiTrak data will be recorded under the job number 
indicated when the job selection was made. Recording is indicated by the data point number on the 
TensiTrak locate mode screen increasing every 4 seconds. Otherwise, no data will be recorded and the 
data point number on the TensiTrak locate mode screen will remain at zero.  

Reamer 

Swivel 
Product 

TensiTrak  
transmitter 

Leading end  
with battery compartment 

Trailing end  
with mud pressure sensor 

D-ring D-ring 
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Recording Data and  
Using Receiver Menus 

Once your TensiTrak job is properly set up in the field, then you can begin to record data. As discussed 
previously, when the TensiTrak batteries are installed, the unit immediately begins saving data. The F5 
receiver begins receiving, displaying, and saving data after the pressure-tension (P-T) DataLog function is 
enabled and a job has been started.  

The receiver menus used to start, stop, and pause data recording, to record flags along the pullback/drill 
path, and to delete jobs from the receiver are discussed in this section. These menus are located under 
the P-T DataLog menu. The P-T DataLog menu is also used for the F5 fluid pressure transmitter, but only 
its applications for the TensiTrak system are addressed here. 

Pressure-Tension DataLog Menu   
 

Before you can record data, the P-T DataLog function must be enabled. From the receiver main menu, 
select the P-T DataLog option (icon shown above) to display the following menu. 

 

Pressure-Tension DataLog Menu 

From this menu, select the option to enable/disable the P-T DataLog function if it is red (indicating the 
function is disabled). It will turn green (as shown above) to indicate the function is now enabled. If the 
option is green when you enter the menu, then the function is already enabled.   

Exit (returns to 
main menu) 

Enable/disable P-T 
DataLog function 
(shown enabled, 
appears red when 

disabled) 

Description of 
highlighted option 

Upload job data  

to computer  

Delete job or jobs  
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Start Recording Menu 

With the P-T DataLog function enabled, the screen shown below will display when you click the trigger to 
go to the locate mode screen from the main menu. You can also access the recording menu from the 
locate mode by toggling right.  

 

Start Recording Menu 

To open a new job, select the start new job option. When starting a new job, note the job number for 
reference later. If you want to open an existing job and continue adding data to it, select the option to 
append existing job.  

If you do not open a job (select exit), the start recording menu will display again when the toggle switch is 
pushed to the right. You must select either the option to start a new job or the option to append an 
existing job before a job will be opened and data recorded.  

Once a selection is made, the locate mode screen will display showing TensiTrak data. If a recording 
option was chosen, the data point number recorded will advance every 4 seconds to show data is being 
recorded.  

 

Receiver TensiTrak Locate Mode Screen  

Create new job 

Exit  

 

Append existing job 

 

Data point number 

recorded  

Signal strength 

Maximum force  
on TensiTrak 

during job 

Number of 
flags set 

TensiTrak 
temperature 

Annular mud 
pressure 

Instantaneous 

product pull force  
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Stop/Pause Recording Menu 

If a job is being recorded and you exit the locate mode screen (toggle down), the screen shown below will 
display. 

 

Stop/Pause Recording Menu 

If you select the pause recording option, the job will remain open with no data recording until the receiver 
is shut down. When you re-enter the locate mode screen, the start recording menu will not display and 
data will automatically continue recording on the job number indicated. 

The stop recording option will close the job. Once a job is closed, it is available for upload to a computer 
or it can be reopened and additional data can be recorded by selecting the option to append existing job 
in the start recording menu.  

Flag Recording Menu 

The flag recording menu is accessible only when a TensiTrak job is already running and the receiver is in 
locate mode. From the locate mode screen, push the toggle switch to the right, and the screen shown 
below will display. 

 

Flag Recording Menu 

Pause recording Stop recording 

 

Exit (returns to locate 
mode screen with no 

new flag recorded)  

Set a flag 
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DCI recommends that you record flags at various points to help correlate physical locations along the 
pullback/drill path with the TensiTrak data points. To record a flag, from the flag recording menu, select 
the option to set a flag. Once a flag is recorded, it cannot be deleted from the TensiTrak data file. Keep a 
separate log of the flag numbers and details of the location where the flag was recorded (such as entering 
under road, exiting under road, etc.). You will want to add this information to the TensiTrak data file after it 
is uploaded to a computer.  

If you do not want to set a flag, toggle right and select exit to return to the locate mode screen without 
recording a flag location.  

Deleting TensiTrak Jobs 

From the receiver main menu, select the P-T DataLog menu option. Then select the option to delete a job 
or jobs, and you will go to the delete TensiTrak jobs menu, shown below.  

 

Delete TensiTrak Jobs Menu 

You can either delete one job or delete all jobs in the receiver. Once you delete a job from the receiver, 
you cannot recover it. Make sure you have uploaded all jobs to the computer before you delete jobs from 
the receiver. 

 

Delete one job Delete all jobs 
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Installing LWD Software  

Computer System Requirements 

The LWD software requires a computer with at least the following system specifications: 

 Microsoft Windows XP, Vista, or 7 operating system 
 USB port 
 Pointing device (mouse)  
 Color printer for color graphs  

The LWD software is provided on a USB flash drive that also contains this operator’s manual, sample drill 
data, Bluetooth drivers, and software for using the system with an MFD remote. If you are using an MFD 
remote with your F5 system, please contact DCI Customer Service so that we can assist you in upgrading 
your MFD software. 

Installation Instructions 

The LWD program files will automatically be placed under the C:\Program Files folder in a new folder 
(C:\Program Files\DCI\DigiTrak LWD). You can change this default storage location during installation.  

The LWD data files and sample data files will automatically be placed under My Documents\DCI. You can 
also change this default storage location during installation. 

To install the LWD software: 

1. Close any open applications.   

2. Put the LWD flash drive into a USB port and view the contents of the drive in your computer. Click on 
the LWD Kit folder.  

3. Double click on Drivers for LWD to install these first. 

4. Double click on the Bluetooth Driver folder, then double click on the *.exe file to install the drivers. 

5. Double click on the DigiTrak LWD Software folder, and then double click on the setup.exe file to 
install the LWD software. 

6. Once the LWD drivers and software have been installed, you will see a shortcut icon  on your 

desktop and under All Programs in your Start menu (in lower left corner of computer screen).  
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You can start the program by using the LWD shortcut icon or the Start button path or by clicking on the 
DigiTrakLWD.exe file in Windows Explorer. When the program opens, a blank LWD application window 
will display, as shown below.  

 

LWD Blank Application Window 

For instructions on using the LWD software for the TensiTrak system, see the Using LWD Software 
section. 
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Uploading Data  
from Receiver to Computer 

The instructions for uploading TensiTrak jobs from the F5 receiver to your computer are provided below. 
The procedure involves adding the F5 receiver to the LWD software’s Bluetooth device list and then 
uploading the files to the computer via the Bluetooth connection. Only basic instructions for using the 
LWD software to upload data are discussed here. For full instructions on using the LWD software, see the 
next section, Using LWD Software.  

Adding F5 Receiver to LWD Bluetooth Device List 

The first time an F5 receiver is used with the LWD software on your computer, you must add it to the 
Bluetooth device list in the LWD software, as instructed here. 

First, power up both the F5 receiver and the computer. Then, insert the Bluetooth USB adapter (Amp’ed 
RF Model BT-210) into a USB port on the computer. Continue with the procedure as follows. 

On the Receiver 

1. Open the system information screen from the receiver main menu by selecting 
the system information option (icon shown to the right). 

2. Note the receiver identification number and the Bluetooth device address, which 
you will need to enter into the LWD software on the computer. 

 

Receiver System Information Screen 

Receiver 
identification 

number  

Bluetooth device 
address  

 

System  
Information 
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On the Computer 

1. Start up the LWD program by using the LWD shortcut icon or the Start button path or by clicking on 
the DigiTrakLWD.exe in Windows Explorer. 

2. Select the View | Bluetooth Device List option on the menu bar or click on the Bluetooth icon  in 

the tool bar to open the Bluetooth Device List dialog box. 

 

Bluetooth Device List Dialog Box 

3. Enter the Bluetooth device address from the receiver system information screen in the specified text 
field.  

4. Enter a name for the F5 receiver in the Bluetooth device name text field. We recommend that you use 
the receiver identification number shown on the receiver system information screen in the name. 

5. Click on Add.  

6. Click on OK. The device you added will appear in the Bluetooth device list. 

You are now ready to upload job data. 

Uploading Data from Receiver to Computer 

Once the F5 receiver has been added to the Bluetooth device list, you can upload TensiTrak job files. DCI 
suggests that you upload your data to a computer following every TensiTrak job. The Bluetooth adapter 
must remain in the USB port of the computer during the upload process. 

Bluetooth devices 

previously added  Address text field  

Name text field  
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On the Receiver 

1. Open the pressure-tension DataLog menu from the receiver main menu. 

2. Select the option to upload a job, and the P-T DataLog job list will display as shown below. 

 

Pressure-Tension DataLog Job List 

3. From the P-T DataLog job list, select the TensiTrak job number (for example, PT-Job #8 above) that 
you want to upload to the computer. Data must be communicated within 15 minutes or the receiver 
will shut down. 

On the Computer 

1. Start up the LWD program. 

2. Select the File | New command on the menu bar or click on the new document icon    in the tool 

bar.  

3. Select Pressure-Tension | OK, and a blank form will display.  

4. Select File | Upload Control command on the menu bar or click on the connection icon    in the 

tool bar. The Pressure/Tension Monitor Upload Control dialog box will display.  

5. Select “Silicon Labs CP210x USB to UART Bridge (COM#)” from the Serial Port Connection pull-
down list.  

6. Select the F5 receiver name from the Bluetooth pull-down list.  

7. Click on “Connect to Device” to establish communication and begin the data transfer. 

8. After the data has been transferred, the TensiTrak DataLog Job Info screen will appear. You may 
choose to enter the requested details now or later. 

9. Click on OK. The data information fields and the force and pressure charts in the LWD application 
window will fill with data.  

See the Using LWD Software section below and the help files in the LWD software for more information 
on interpreting, editing, and sharing the data. 

TensiTrak  
job number  
highlighted  

for selection  
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Using the LWD Software 

Starting the LWD Program and Opening Files 

There are three ways to start the LWD program:  

 Double-click on the LWD icon    on the desktop. 

 Use the Start button (in lower left corner of computer screen) and select Start | All Programs | 

DigiTrak LWD |    DigiTrak LWD. 

 From Windows Explorer, click on the DigiTrakLWD.exe file under the default folder “C:\Program 
Files\DCI\DigiTrak LWD” or the folder you have designated for the storage location.  

After you start up the program, the application window will display without data, as shown in the Installing 
LWD Software section. From the blank application window, use the File | New command on the menu bar 

(or the new document icon  in the tool bar) to start a new TensiTrak job file. A blank form as shown 

below will display.  

 

LWD Pressure-Tension Application Window (without data) 

Tool bar 

Status bar 

Pressure and  
force charts 

Data  
point list 

Site 
information 

Job 
information 

Menu bar 
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To open an existing TensiTrak file from the blank application window, use the File | Open command (or 

the file open icon ). You can also open a TensiTrak file directly from Windows Explorer or as an email 

attachment. The file extension for a TensiTrak file is *.TT5. When a file is opened, the data information 
fields and the force and pressure charts are filled with data, as shown below.  

 

LWD Pressure-Tension Application Window (with data) 

The LWD application menus and tool bar icons are described in the following subsection, and the 
different information fields (site information, job information, data point list, and pressure and force charts) 
are described afterward. 

Throughout the LWD program, a tool tip helper can be used to understand different parts of the 

application window and file. Click on the tool tip helper icon in the tool bar    and click on a point of 

interest within the document.  

Also, it is useful to view the help files in the LWD software and help wizards that appear to guide you 
through dialog box commands. If you do not want a help wizard to appear, click in the box next to “Show 
Wizard” to uncheck the box and close the help wizard.  
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Menu and Tool Bars 

Under each menu item on the menu bar (File, Edit, View, Window, and Help) are commands for running 
the LWD program. Many of the commands are similar to those used in other Windows programs and 
have associated icons on the Tool bar. The menu commands and associated tool bar icons are 
summarized below. You can also move the cursor over any icon on the screen for a brief description of its 
function. 

File Menu Commands  

New 
 

Opens the “New” project window where you select the job type to be created 
(pressure-tension for a TensiTrak job). Once a selection is made in this 
window, a new blank job screen appears. 

Open 
 

Allows you to select an existing project to open from the Windows browser. 

Save 
 

Saves an opened project using the same file name and folder as designated 
previously. 

Save As  Saves an opened job to a specified file name and folder. When a new file has 
not been saved, selecting the save icon on the tool bar will open the same 
screen as the Save As menu command. 

Print  Opens the print window where you can select printing options and print the 
job. 

Print Preview  Displays the project on the screen as it would appear printed. 

Print Setup  Allows you to select a printer and printer connection as well as the paper size 
and orientation. 

Import 
Eclipse Data 

 Allows you to import Eclipse TensiTrak data files previously saved on a 
computer.  

Export 
Spreadsheet 

 Exports a spreadsheet compatible comma-separated value (*.csv) Unicode 
text file so you can share charts using standard spreadsheet software. 

Upload Data  Launches the Pressure/Tension Monitor Upload Control dialog box where you 
can link to a receiver for uploading files. 

File 1, 2…  Opens the specified previously opened file. 

Exit  Exits DigiTrak LWD program. 
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Edit Menu Commands 

Site 
Information 

 
Opens the Site Information dialog box where you can enter and edit the 
location and contact information that displays in the “Site Information” field in 
the upper left corner of the application window. General comments about the 
job may also be entered in the Site Information dialog box. This dialog box 
can also be accessed by double-clicking in the Site Information field of the 
application window. 

Display Units 
 

Opens the Edit Display Units dialog box where you can select the depth, 
pitch, temperature, and force/pressure units displayed on the charts in the 
application window. The depth unit setting in the receiver will determine the 
units that will display. 

Job 
Information 

 
Opens the TensiTrak DataLog Job Information dialog box where you edit 
details specifically associated with the TensiTrak job such as the upper limit 
for force and pressure readings acceptable for the job, the size and type of 
product being installed as well as the direction it was installed. This dialog box 
can also be accessed by double-clicking in the Job Information field of the 
application window. 

Pressure 
Chart 
Annotations 

 
Opens the Edit Pressure Chart Annotations dialog box where you can make 
comments and insert drawings to appear on the pressure chart. The pressure 
chart annotations dialog box can also be opened by holding the shift key 
down and using the mouse button to draw a box in the chart field. 

Force Chart 
Annotations 

 
Opens the Force Chart Annotations dialog box where you can make 
comments and insert drawings to appear on the force chart. The force chart 
annotations dialog box can also be opened by holding the shift key down and 
using the mouse button to draw a box in the chart field. 

Pressure 
Chart 
Properties 

 
Opens the Edit Pressure Chart Extents and Mode dialog box where you can 
adjust the scaling of the Pressure Chart. 

Force Chart 
Properties 

 
Opens the Edit Force Chart Extents and Mode dialog box where you can 
adjust the scaling of the Force Chart. 

 

In addition to the commands listed above on the Edit menu, there are five options that are unavailable 
(grayed out) because they pertain to other LWD applications, such as the Short Steering Tool and the 
Drill DataLog applications. 

View Menu Commands  

Tool Bar  Shows or hides the tool bar. 

Status Bar  Shows or hides the status bar. 

Bluetooth 
Device List   

 
Shows a list of registered Bluetooth devices. 
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Window Menu Commands 

New Window  Opens the current document in a new window. 

Cascade  Arranges windows in an overlapped fashion. 

Tile  Arranges windows in nonoverlapped tiles. 

Arrange Icons  Arranges icons of minimized windows. 

Window 1, 2…  Goes to specified window. 

 

Help Menu Commands 

Help Topics 
 

Offers you an index to topics on which you can get help. 

Help About  Displays the version number of DigiTrak LWD software. 

Tool Tip 
Helper 

 
Serves as a shortcut to help topics. Click on this icon in the tool bar, and then 
click on a point of interest within the application. The help file associated with 
that part of the application window will open. 

 

Information Fields 

The P-T application in the LWD software displays information grouped in related fields as discussed 
briefly below. Detailed information on reading and editing the data fields are provided in the software’s 
help files. Use the tool tip helper or view help topics for more information. 

Site Information 

The Site Information section displays the job location and client information. Visible on the screen are: 

 Job Name  
 Job Address line 1, line 2 and City.  
 Client Name  
 Contact Phone  

All the address and contact information for the job, client, and contractor are listed on the printed 
document. See Print and Print Preview commands. 

There are three ways to open the Site Information dialog box where Site Information can be edited. Select 
the Site Information command in the Edit menu. Click on the Site Information icon on the tool bar. Or 
double-click anywhere in the Site Information field of the application window. 
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Job Information 

The Job Information section displays statistical information about the job. This information includes: 

 Date the job was started on the F5 receiver, which is retrieved from first uploaded data point.  
 Serial number of the receiver used to collect data  
 Job ID or the number the job was on the receiver 
 Number of Data Points collected   
 Pressure measurement units (PSI or kPa - see Set Display Units)  
 Force measurement units (lbf or kNt - see Set Display Units)  

The data points, job ID, date, and measurement units are listed on the printed document. See Print and 
Print Preview commands. 

The measurement units can be edited from the Display Units command in the Edit menu or by clicking the 
edit units icon in the tool bar.  

There are three ways to open the Job Information dialog box where you can edit pressure and tension 
limit thresholds, the direction of the graphed data, as well as details about the materials which show on 
the printed document. Select the Job Information command in the Edit menu. Click on the Job Information 
icon on the tool bar. Or double-click anywhere in the Job Information field of the application window. 

Data Point List 

The Data Point list is a table displaying all of the data points in the job and the associated data. View help 
files for additional information. The columns in the table include: 

 Data Point 
This column displays the number and status of the data point.  

 Force 
This column displays the force value recorded by the receiver at the specified data point. Units 
are those displayed in the Job Information field. An “x” indicates no data.  

 Max F. 
This column displays the maximum force value recorded by the receiver at all data points up to 
the one indicated. Units are those displayed in the Job Information field. An “x” indicates no data. 

 Pres. 
This column displays the pressure value recorded by the receiver at the specified data point. 
Units are those displayed in the Job Information field. An “x” indicates no data. 

 Data Flag 
If a flag was recorded on the F5 receiver at a specified data point, the flag number would be 
noted in this column. 

 Date/Time 
This column displays the date and time the specified data point was recorded. This information 
does not show on the charts or printed report. 
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Pressure and Force Charts 

The pressure and force charts give a graphical representation of the information contained in the Data 
Points field and can be annotated to provide additional details about the job. The common features of the 
two charts are discussed below. See the Help topics in the LWD software for more information. 

 Data Points – The X-axis shows the numeric value of the charted data points.  

 Values – The Y-axis of each graph shows the corresponding pressure or force value of the points 
on the graph.  

 Cursor Coordinates – When the cursor is placed anywhere on either graph, the value of the 
coordinates at that position display. If the cursor is placed on a data point, both the force and 
pressure values recorded at that data point will display. 

 Flags – When a flag is set at a data point, a green dot larger than the data point appears with the 
flag number indicated nearby. 

 Zoom – To zoom into an area of the chart, hold down the control button on your computer then 
click and hold on your mouse while you drag the pointer through the area you wish to explode. 
Release the mouse button once the area is selected. To return the chart to its normal scaling, 
hold the control button down on the computer and click the mouse button in the chart area. 

Mud Pressure Chart  

The Mud Pressure Chart shows the downhole mud pressure (in pounds-per-square-inch or kilo-Pascals) 
at each data point. If a pressure limit threshold was set, data points will be magenta or red as the 
pressure threshold is approached or exceeded. In the case below, the pressure limit threshold was set to 
45 psi.  

 

Mud Pressure Chart 

Pull Force Chart  

The Pull Force Chart shows the product pull force measured in force-pounds (lbf) or kilo-Newtons (kN) at 
each data point. If a force limit threshold was set, data points will be magenta or red as the force 
threshold is approached or exceeded. In the case below, the force limit threshold was set to 40,000 lbf.  

 

Pull Force Chart 
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Editing and Annotating Charts 

The Pressure and Force charts can be edited and annotated in a number of ways. Data points can be 
removed in the Data Points list to reduce the amount of data that appears on the charts. Shapes and 
captions can be drawn directly on the chart to describe job site conditions and other points of interest on 
the graph using the Edit Chart Annotations commands. And the boundaries of the charts can be changed 
using the Edit Chart Properties commands. The help files in the LWD software provide full instruction on 
all editing capabilities. The instructions below are basic to getting started with the chart editing functions. 

Removing Data Points 

Select a group of data points to remove from the graphs by clicking on either chart near where you would 
like to begin removing data. The Data Points list will adjust to show the group of data points near where 
the click was made. Click on the first data point you would like to remove from the list and hold the shift 
key down. Then click on the last data point you would like to remove from the list. Right click in the Data 
Points list area and select the Remove option. The data points you selected will no longer show on the 
charts. The Data Points list will indicate the points have been removed from the chart.  

Drawing Shapes and Adding Captions 

There are three ways you can access the Pressure or Force Chart Annotations dialog boxes where you 
can draw shapes and enter information to be included on the chart graph and printed report.  

 Select the Pressure or Force Chart Annotations command from the Edit menu.  

 Click on the Edit Force or Pressure Chart Annotations icon on tool bar.  

 Or hold the shift key down and use the mouse to draw a box around the area you would like a 
shape to appear on the chart. If the box is drawn in the pressure chart, the pressure annotations 
dialog box will open. If the box is drawn in the force chart, the force annotations dialog box will 
open. The Location area of the dialog box will be automatically filled with the coordinates of the 
box you drew. 

Both the pressure and force annotation boxes function in the same way, only the coordinates shown in 
the Location and Caption sections of the dialog boxes will be different. If you open the chart annotations 
dialog box using the menu command or tool bar icon, you will need to enter the coordinates of the shape 
you wish to draw in the Location section of the dialog box. 

Selecting and Editing Shapes 

Select the shape you would like to appear on the chart from the pull-down menu in the Location section of 
the chart annotations dialog box.  

Adjust the line weight and font size in the Line/Font section of the dialog box.  

Select which parts of the shape you would like to appear in the Draw Shape section of the dialog box.  

The color of the different parts of the shape can be adjusted by double clicking on the ellipses in the Draw 
Shape section of the dialog box. 



Using Software  

36 F5™ TensiTrak
®
 Operator’s Manual 

Adding Captions 

Before a caption can be entered, the check box next to “Draw Caption” in the Draw Shape section of the 
chart annotations dialog box must be checked to activate the Caption section of the dialog box. With the 
Caption section of the dialog box active, type the words you would like to appear on the graph in the 
Caption text box. You do not have to draw a shape to add a caption. 

If a shape is drawn, the caption will appear centered in the shape by default.  

To change the location or orientation of where the caption appears, click in the box next to “Top-Left” in 
the caption section of the dialog box. Enter the coordinates of where you would like the text to begin.  

To change the orientation of the text, type the value of the slope of the text in the Text Slope text box. 

Editing Chart Properties 

To open the Pressure or Force Chart properties dialog boxes where properties such as chart boundaries 
and scaling can be adjusted.  

 Select the Pressure or Force Chart Properties command from the Edit menu.  

 Click on the Edit Force or Pressure Chart Properties icon on tool bar. 

Auto Scale is selected by default. Click in the box next to Auto Scale to adjust the horizontal or vertical 
scaling and chart boundaries. Then manually enter the coordinates of chart boundaries as you would like 
them to appear. 

Printing and Previewing Project Reports  

1. To preview the printed pages before you send the file to print, select Print Preview from the File 
menu or click on the print preview icon on the tool bar. To close the print preview and return to the 
document, click on “Close” in the print preview window. To print the document from the print preview 
window, click on the “Print” button. 

2. To edit printing properties such as the printer, paper size and orientation, select Print Setup from the 
File menu or click on the print setup icon on the tool bar. 

3. There are three ways to print the job data.  

 Select Print from the File menu.  

 Click on the print icon on the tool bar.  

 Or click on “Print” in the Print Preview window.  

4. After a printing option is selected, a Print dialog box will appear. Make any adjustments needed in the 
Print dialog box, then click OK. If you have the Adobe Acrobat PDF writer software, you can select 
the Adobe PDF printer to print to a PDF file (see your Adobe software documentation).  
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5. The job data will print on at least three pages.  

On the first page, the job information including location, client, and contractor information, if entered, 
will appear along with the statistical data about the job and job comments, if any. On the second page 
the force and pressure charts will appear. And on the third page (and more if needed), the top 15% of 
pullback data will be listed by default. You may also select data points to be printed in the data point 
list by right-clicking on a data point and selecting the print option. See the help files for more 
information. 

 

Saving Project Files  

1. To save an open project file, select Save from the File menu or click on the Save icon on the tool bar. 
If the file has been previously named and saved, it will automatically be saved under its current file 
name (shown on the left in the title bar at the top of the main application window) and location. If the 
project is new and has not yet been saved and named, then the Save As window will open where you 
can edit the file name and select the location. The default file name is Pressure-Tension#.tt5. The # 
position starts at 1 and advances automatically as files are saved. 

2. To save an open file with a different file name or location, select Save As from the File menu. You 
will see the Save As dialog box, which automatically opens to the folder where the current file is 
saved. Change the file name and location as desired, then click Save. The open file will now have the 
new file name and/or location.  

DCI recommends saving each job file with two different names in the event that one file becomes 
corrupted.  

 

E-mailing Report to Customer 
Who Does Not Have LWD Software 

The LWD software is able to generate a printed report of your document. 

If you want to send an electronic copy of this printed report, we suggest using a document generating 
printer driver to create a common readable file such as PDF using any of the following: 

 PrimoPDF 
This free software is available for download online at www.primopdf.com. With this software 
installed, you can print the report to PrimoPDF instead of your printer and save the report as a 
PDF file. This file can then be attached to an e-mail. Please refer to PrimoPDF for instructions in 
the use of this product.  
 

 Bullzip PDF Printer 
This free software is available for download online at www.bullzip.com. With this software 
installed, you can print the report to Bullzip PDF Printer and save the report as a PDF file. This 
file can then be attached to an e-mail. Please refer to Bullzip for instructions in the use of this 
product.   
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 Microsoft XPS Printer 
Microsoft has generated a nonstandard encapsulated post script format called .XPS. It is a 
standard Windows component and will probably appear in your printer list. Only Microsoft Internet 
Explorer can present this document type without a translator. If I.E. is not your default browser 
then you or your customer may not be able to view this file type. Please refer to 
http://windows.microsoft.com/en-US/windows-vista/Print-to-the-Microsoft-XPS-Document-Writer 
for instructions on use with your specific operating system.  

Additional information can be found at the website: help.digitrak.com  

Once you have a document writer installed: 

1. From the File menu or the Tool bar, select Print  
2. In the pull-down list, select your PDF writer or Microsoft XPS Document Writer 
3. Click on the 'Properties' button to select 'Portrait' or 'Landscape' format (Landscape is 

recommended).  
4. Click OK to save orientation and dismiss the 'Properties' dialog.  
5. Click OK to save as a *.pdf or *.xps file type.  
6. The 'Save As' dialog will appear.  
7. Choose the location for your file.  
8. Choose the name for your file.  
9. Click OK to save or Cancel to exit.  
10. Attach the saved file (sample.pdf or sample.xps) to your e-mail. The customer can view the file in a 

PDF compatible viewer such as Adobe or a Microsoft XPS compatible viewer such as Internet 
Explorer.  

Alternatively, the printed document can be scanned and attached to an e-mail. 
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Appendix A: System Specifications and 
Maintenance Requirements 

The power requirements, environmental requirements, data accuracy specifications, and maintenance 
requirements for the DigiTrak TensiTrak Pullback and Pressure Monitoring System are listed below. 

Power Requirements 

Device (Model Number) Operational Voltage Operational Current 

DigiTrak TensiTrak Tension 
Monitor (TT and TT5)  

2.7–4.8 V  300 mA max 

 

Environmental Requirements 

Device Relative Humidity Operating Temperature Altitude 

DigiTrak TensiTrak 
Tension Monitor  

<100% 36 to 104° F (2 to 40° C) Up to 6561 ft. (2000 m) 

 

Tension Monitor Pull-Force Data Accuracy 

Temperature Range Tension Range Accuracy 

36 to 41° F (2 to 5° C)    Full ± 5k lb (22.5 kN) 

41 to 104° F (5 to 40° C)    0–10k lb (0–44 kN) ± 1k lb (4.5 kN) 

41 to 104° F (5 to 40° C)    10k–20k lb (45 kN–89 kN) ± 2k lb (9 kN) 

41 to 104° F (5 to 40° C)    20k–100k lb (90 kN–444 kN) ± 3k lb (13.5 kN) 

 
Operating the TensiTrak tension monitor outside of the specified operating temperature range will result 
in tension readings outside of the specifications.  

Mud Pressure Data Accuracy 

Temperature Range Pressure Range Accuracy 

36 to 104° F (2 to 40° C)    0–75 psi (0–517 kPa) ± 3 psi (21 kPa) 

36 to 104° F (2 to 40° C)    75–127 psi (517–876 kPa) ± 10% 
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General Transmitter Care Instructions 

Periodically clean the spring and threads inside the battery compartment as well as the spring and 
threads of the battery end cap to ensure a proper power connection with the batteries. An emery cloth or 
wire brush can be used to remove any oxidation that has built up. Be careful not to damage the battery 
cap O-ring; remove it while cleaning if necessary. After cleaning, use a conductive lubricant on the battery 
cap threads to keep the battery cap from binding in the battery compartment. 

NOTE:  All DCI battery-powered transmitters are shipped with a nickel-based anti-seize lubricant on the 
battery end cap, which aids in electrical grounding for better battery performance.  

Before use, inspect the battery cap O-ring for damage that may allow water to enter the battery 
compartment. Replace the O-ring if the one installed becomes damaged. 

Send in the Product Registration Card for the 90-day Limited Warranty. 

Battery Pack Storage 

If you plan to store the battery packs for any period of time, please follow the guidelines listed below. 

 Do not store the battery pack at temperatures greater than 113° F (45° C). 

 Do not store the battery pack in a fully discharged state. 

 Do not store the battery pack in the battery charger. 

 If the battery pack is going to be stored for an extended period of time, precharge the battery to a 
charge level of 30% to 50% (two or three LEDs illuminated on the battery pack). The battery pack 
should not be stored for more than one year unless it is periodically recharged to the 30% to 50% 
level. 
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General Equipment Maintenance 

Turn off all equipment when not in use.  

Store the equipment in cases, away from heat, cold, and moisture. Test to confirm proper operation prior 
to use. 

Clean the screens on the receiver and remote display using a damp soft cloth without chemicals or 
cleaning agents. 

Clean the receiver, remote, and battery charger case using only a soft moist cloth and mild detergent. 

Do not use chemicals to clean the transmitter. 

Inspect the equipment daily and contact DCI if you see any damage or problems. Do not disassemble or 
attempt to repair the equipment. 

Do not store or ship this equipment with batteries inside. Always remove the batteries from the equipment 
before shipping or periods of non-use. 



 

DIGITAL 

CONTROL 

INCORPORATED 

19625 62nd Ave S, Suite B103 

Kent Washington 98032, USA 

425.251.0559 / 800.288.3610 

dci@digital-control.com, www.DigiTrak.com 
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LIMITED WARRANTY 

Digital Control Incorporated ("DCI") warrants that when shipped from DCI each DCI Product will conform to DCI’s current published 
specifications in existence at the time of shipment and will be free, for the warranty period (“Warranty Period”) described below, from 
defects in materials and workmanship. The limited warranty described herein (“Limited Warranty”) is not transferable, shall extend only to 
the first end-user (“User”) purchasing the DCI Product from either DCI or a dealer expressly authorized by DCI to sell DCI Products 
(“Authorized DCI Dealer”), and is subject to the following terms, conditions and limitations: 

1. A Warranty Period of twelve (12) months shall apply to the following new DCI Products: receivers/locators, remote displays, battery 
chargers and rechargeable batteries, and DataLog

®
 modules and interfaces. A Warranty Period of ninety (90) days shall apply to all 

other new DCI Products, including transmitters, accessories, and software programs and modules. Unless otherwise stated by DCI, 
a Warranty Period of ninety (90) days shall apply to: (a) a used DCI Product sold either by DCI or by an Authorized DCI Dealer who 
has been expressly authorized by DCI to sell such used DCI Product; and (b) services provided by DCI, including testing, servicing, 
and repairing an out-of-warranty DCI Product. The Warranty Period shall begin from the later of: (i) the date of shipment of the DCI 
Product from DCI, or (ii) the date of shipment (or other delivery) of the DCI Product from an Authorized DCI Dealer to User. 

2. DCI’s sole obligation under this Limited Warranty shall be limited to either repairing, replacing, or adjusting, at DCI’s option, a 
covered DCI Product that has been determined by DCI, after reasonable inspection, to be defective during the foregoing Warranty 
Period. All warranty inspections, repairs and adjustments must be performed either by DCI or by a warranty claim service authorized 
in writing by DCI. All warranty claims must include proof of purchase, including proof of purchase date, identifying the DCI Product 
by serial number. 

3. The Limited Warranty shall only be effective if: (i) within fourteen (14) days of receipt of the DCI Product, User mails a fully 
completed Product Registration Card to DCI; (ii) User makes a reasonable inspection upon first receipt of the DCI Product and 
immediately notifies DCI of any apparent defect; and (iii) User complies with all of the Warranty Claim Procedures described below. 

WHAT IS NOT COVERED 

This Limited Warranty excludes all damage, including damage to any DCI Product, due to: failure to follow DCI’s operator’s manual and 
other DCI instructions; abuse; misuse; neglect; accident; fire; flood; Acts of God; improper applications; connection to incorrect line 
voltages and improper power sources; use of incorrect fuses; overheating; contact with high voltages or injurious substances; use of 
batteries or other products or components not manufactured or supplied by DCI; or other events beyond the control of DCI. This Limited 
Warranty does not apply to any equipment not manufactured or supplied by DCI nor, if applicable, to any damage or loss resulting from 
use of any DCI Product outside the designated country of use. By accepting a DCI Product and not returning it for a refund within thirty 
(30) days of purchase, User agrees to the terms of this Limited Warranty, including without limitation the Limitation of Remedies and 
Liability described below, and agrees to carefully evaluate the suitability of the DCI Product for User’s intended use and to thoroughly read 
and strictly follow all instructions supplied by DCI (including any updated DCI Product information which may be obtained at the above DCI 
website). In no event shall this Limited Warranty cover any damage arising during shipment of the DCI Product to or from DCI. 

User agrees that the following will render the above Limited Warranty void: (i) alteration, removal or tampering with any serial number, 
identification, instructional, or sealing labels on the DCI Product, or (ii) any unauthorized disassembly, repair or modification of the DCI 
Product. In no event shall DCI be responsible for the cost of or any damage resulting from any changes, modifications, or repairs to the 
DCI Product not expressly authorized in writing by DCI, and DCI shall not be responsible for the loss of or damage to the DCI Product or 
any other equipment while in the possession of any service agency not authorized by DCI. 

DCI reserves the right to make changes in design and improvements upon DCI Products from time to time, and User understands that DCI 
shall have no obligation to upgrade any previously manufactured DCI Product to include any such changes. 

THE FOREGOING LIMITED WARRANTY IS DCI’S SOLE WARRANTY AND IS MADE IN PLACE OF ALL OTHER WARRANTIES, 
EXPRESS OR IMPLIED, INCLUDING BUT NOT LIMITED TO THE IMPLIED WARRANTIES OF MERCHANTABILITY AND FITNESS 
FOR A PARTICULAR PURPOSE, IMPLIED WARRANTY OF NON-INFRINGEMENT, AND ANY IMPLIED WARRANTY ARISING FROM 
COURSE OF PERFORMANCE, COURSE OF DEALING, OR USAGE OF TRADE, ALL OF WHICH ARE HEREBY DISCLAIMED AND 
EXCLUDED. If DCI has substantially complied with the warranty claim procedures described below, such procedures shall constitute 
User’s sole and exclusive remedy for breach of the Limited Warranty. 

http://www.digitrak.com/
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LIMITATION OF REMEDIES AND LIABILITY 

In no event shall DCI or anyone else involved in the creation, production, or delivery of the DCI Product be liable for any 
damages arising out of the use or inability to use the DCI Product, including but not limited to indirect, special, incidental, or 
consequential damages, or for any cover, loss of information, profit, revenue or use, based upon any claim by User for breach of 
warranty, breach of contract, negligence, strict liability, or any other legal theory, even if DCI has been advised of the possibility 
of such damages. In no event shall DCI’s liability exceed the amount User has paid for the DCI Product. To the extent that any 
applicable law does not allow the exclusion or limitation of incidental, consequential or similar damages, the foregoing 
limitations regarding such damages shall not apply. 

This Limited Warranty gives you specific legal rights, and you may also have other rights which vary from state to state. This Limited 
Warranty shall be governed by the laws of the State of Washington. 

WARRANTY CLAIM PROCEDURES 

1. If you are having problems with your DCI Product, you must first contact the Authorized DCI Dealer where it was purchased. If you 
are unable to resolve the problem through your Authorized DCI Dealer, contact DCI’s Customer Service Department in Kent, 
Washington, USA at the above telephone number between 6:00 a.m. and 6:00 p.m. Pacific Time and ask to speak with a customer 
service representative. (The above “800” number is available for use only in the USA and Canada.) Prior to returning any DCI 
Product to DCI for service, you must obtain a Return Merchandise Authorization (RMA) number. Failure to obtain an RMA may 
result in delays or return to you of the DCI Product without repair. 

2. After contacting a DCI customer service representative by telephone, the representative will attempt to assist you in troubleshooting 
while you are using the DCI Product during actual field operations. Please have all related equipment available together with a list of 
all DCI Product serial numbers. It is important that field troubleshooting be conducted because many problems do not result from a 
defective DCI Product, but instead are due to either operational errors or adverse conditions occurring in the User’s drilling 
environment. 

3. If a DCI Product problem is confirmed as a result of field troubleshooting discussions with a DCI customer service representative, 
the representative will issue an RMA number authorizing the return of the DCI Product and will provide shipping directions. You will 
be responsible for all shipping costs, including any insurance. If, after receiving the DCI Product and performing diagnostic testing, 
DCI determines the problem is covered by the Limited Warranty, required repairs and/or adjustments will be made, and a properly 
functioning DCI Product will be promptly shipped to you. If the problem is not covered by the Limited Warranty, you will be informed 
of the reason and be provided an estimate of repair costs. If you authorize DCI to service or repair the DCI Product, the work will be 
promptly performed and the DCI Product will be shipped to you. You will be billed for any costs for testing, repairs and adjustments 
not covered by the Limited Warranty and for shipping costs. In most cases, repairs are accomplished within 1 to 2 weeks. 

4. DCI has a limited supply of loaner equipment available. If loaner equipment is required by you and is available, DCI will attempt to 
ship loaner equipment to you by overnight delivery for your use while your equipment is being serviced by DCI. DCI will make 
reasonable efforts to minimize your downtime on warranty claims, limited by circumstances not within DCI’s control. If DCI provides 
you loaner equipment, your equipment must be received by DCI no later than the second business day after your receipt of loaner 
equipment. You must return the loaner equipment by overnight delivery for receipt by DCI no later than the second business day 
after your receipt of the repaired DCI Product. Any failure to meet these deadlines will result in a rental charge for use of the loaner 
equipment for each extra day the return of the loaner equipment to DCI is delayed. 

 


